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Introduktion

IFC (Industry Foundation Classes) dr ett neutralt och dppet filformat som mojliggor
informationsutbyte mellan olika CAD-program och andra mjukvaror inom bygg och
forvaltning. IFC-formatet dr ISO-certifierat och kan integreras i det kvalitetssikringssystem
som ditt kontor har valt. IFC &r utvecklat av IAI — International Alliance for Interoperability

som idag har mer 4n 600 medlemsforetag runt om i varlden. Fér mer information se:
http://www.buildingsmart.com/

GRAPHISOFT har spelat en aktiv roll inom IAI sedan 1996 och stodjer IFC-standarden vilket
ger ArchiCAD mgjlighet att kommunicera med andra discipliner och att koordinera
byggnadsprojekt 1 3D. Byggmodellen kan exporteras till hundratals andra system som stodjer
IFC.

BIM, eller Building Information Modeling, &r en av de storsta landvinningarna inom
byggbranschens arbetsmetoder sedan introduktionen av CAD. BIM &r INTE synonymt med
3D. Geometrisk representation av byggnadselement i 3D (3D-CAD) ér bara en av delarna i
BIM-konceptet. Ett verkligt projekt innehdller icke-grafisk information som berdkningar och
mingder for utséttare, forvaltning, energiberdkningar, akustik mm. En forutsittning for
effektivt BIM-projekt ér att intelligent information kan vixlas mellan olika mjukvaror (och
operativsystem) genom alla skeden i byggprocessen. Denna "interoperabilitet” krdver ett
neutralt och 6ppet filformat som alla mjukvaror kan anvénda och ocksé ar ett format som dgs
och utvecklas av branschen och inte av specifika mjukvaruleverantorer. IFC ér ett dylikt
system som gor det mojligt att synkronisera byggnadsmodeller mellan mjukvaror och
discipliner pé ett effektivt sitt.

Med ett anvéndarvinligt granssnitt och stora mdjligheter till anpassning dr ArchiCADs IFC-
funktioner enkelt atkomliga och kan anvindas av bade proffs och nybdrjare.

Denna guide ger inblick 1 sjdlva IFC-standarden samt hur den fungerar i ArchiCAD. IFC-
versionen for ArchiCAD 14 ar IFC 2x3.

Obs: Tidigare IFC-versioner (2x2) finns att ladda ner fran Graphisofts internationella
hemsida.
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Grundkunskaper IFC

IFC Elementtyp och klassificering

GRAPHISOFT.

Varje byggelement (2D och 3D) i ArchiCAD har en direkt mappning till sin motsvarighet i
IFC-strukturen (IFC element type). Foljande tabell visar standardkopplingen fran ArchiCAD

till IFC.

ArchiCAD Ele ment type IFC Element type ArchiCAD Element type IFC Element type
Wall IfcWallStandardCase Ohject= Wall Ife\all
Door IfcDoor Object= Door IfcDoor
Window IfcyWindow Object= Window IfcyWindow
Skylight IfcWindow Object= Opening IfcBuildingElementP roxy
Roof IfcSlab Object= Roof IfcSlab
Beam IfcBearn Object= Beam IfcBearm
Column IfcColumn Object= Column IfcColumn
Slab IfcSlab Object= Pile IfcPile
Stair IfcStair Object= Slah IfcSlab
Ramp (Stair Maker) IfcStair Ohject= Precast Slab IfcSlab
Mesh IfcSite Object= Plate IfcPlate
Curtain Wall IfcCurtainwall Object= Member Ifc Member
Zone IfcSpace Object= Tendon IfcTendon
Dimension IfcAnnotation Object= Stair IfcStair
Level Dimension IfcAnnotation Ohject= Stair Flight IfcStairFlight
Text IfcAnnotation Object> Ramp IfcRamp
Label IfcAnnotation Ohject= Ramp Flight IfcRampFlight
Fill IfcAnnotation Object= Railing IfcRailing
Line IfcAnnotation Object= Curtain Wall Ifc Curtainivall
ArciCircle IfcAnnotation Object= Furnishing IfcFurnishingElement
Polyline IfcAnnotation Object= Wood Truss IfcBeam
Grid Element Ifc GridAxis Object= Foundation IfcFooting
Grid System Ifc Grid Object= Footing IfcFooting
Wall End Ifciall Object= Space IfcSpace
Corner-¥indow Ifciindow Object= Covering IfcCovering
Lamp IfcFlowTerminal Ohject= Reinforcing Bar IfcReinforcingBar

Radial Dimension

IfcAnnotation

Object= Reinforcing Mesh

IfcReinforcinghMesh

Angle Dimension

IfcAnnotation

Object= Wall End

Iicivall

Spline

IfcAnnotation

Object= Electrical Element

IfcFlowTerminal

Object= Flow Fitting

IfeFlowFitting

Object= Flow Terminal

IfcFlowTerminal

Object= Flow Segment

IfcFlowSegment

Object= Transport Element

IfcTransportElement

Object= Mechanical

IfcBuildingElementProxy

I vissa fall behdver man modellera element som inte har en direkt motsvarighet i ArchiCADs
verktygslada. T ex kan man anvénda bjélklagsverktyget for att modellera ett undertak. Vid
export till IFC kommer dd undertaket automatiskt att bli definierat som IfcSlab. ArchiCAD
har dock ett effektivt hjdlpmedel for att modifiera IFC-definitionen genom att markera
bjilklaget och 1 Settingsfonstret vilja IFC Element Type = Ceiling enligt fig. nedan.
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N06 Slab Selection Settings

Selected: 1 Editable: 1

@1 Geometry and Positionina
[ Floor Plan and Section
<4 Model

g8 Listing and Labeling

ID: 8j1

™ Link Properties By Criteria

O Individually

Label Slab Label Se

> v Automatic

Undefined o

it
Structural Function Undefined Ceiling
lumn

Col

£F [® Bjalklag

Det ér alltsa mycket enkelt att modifiera IFC-klassificeringen 1 din ArchiCAD-modell. I de
fall du importerar en IFC-modell frin t ex konstruktdren kan du anvinda IFC Manager for att
”fraga” vilket IFC Element type som elementet har, se fig. nedan. IFC Manager beskrivs 1 den
avancerade delen av guiden.

Column
Structure: HEB200

'WyD: 200 § 200
Layer: Structural - Bearing IFC Import
Story: 0

TFC Manager - IFC 2 Edition 3

Contsinment Structure E)E Create New Propesty
= @ Undefined - Name Vahse Uk Type
= B Undefred

® Tl Beams (4)

= T Cohures (2)
% E FeBeamType - L1S0* S
= & FeColmnType - HEE:

i e -
§ rese0 & ObjectType MER200
§ e o
< > ¥ Pset_Tekla_General
r 1 Grade SZER Feldentiis
Search by GUID B Grade Ideckter
~ ~ o Class 98 Heldentier
— & Frsh Feldertfme
Grouping Information: SUE) 9 Assentiyld AG) Hclgectine
= _) Grouping information & part_postion PJOY) Heldeotfier
() IFC Groups Pset_ColumnCommon
() IFC Zones

Pset_ConcretetlementGeneral
Pset_ConcretetlementQuantit...
Pset_ConcretetlementSurface...
Pset_PrecastConcretetlement...
Pset_ReinforcementBarPitchr...
Pset_Draughting
Pset_tlementShading
Pset_FireRatingProperties
Pset_ManufacturerDccurrence

[ Show Selection n Tree )

vVYVYVVVYTVYTVYTYY

[ ‘Show Selection on Fioor Plan

L Syncheonize Tree to Plan

Obs:

* Element som importeras till ArchiCAD och inte har ndgot motsvarighet 1 ArchiCAD
konverteras till Objekt (ex objekt av balktyp, ytskikttyp etc).

* JFC-klassificeringen har utover korrekt IFC-utbyte en ytterligare fordel. Det gér att
5
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GRAPHISOFT.

anvinda Find&Select och Interactive Schedules for att filtrera pd IFC-klassificeringen.
T ex kan man sortera ut endast de bjdlklag som anvénts for att modellera undertak
utan att behova ldgga dem 1 speciella lager.

Ytterligare klassificering
Element kan utover IFC Element type klassificeras (och ddrmed filtreras) som
exteridra/interiora samt barande/icke-bédrande.

Obs:

Nuvarande IFC-standard stddjer export av ’load—bearing” endast for féljande element: wall,
slab, column, beam och roof. Andra element som definieras som load-bearing kan hanteras
och filtreras med den aspekten endast inom ArchiCAD (t ex med Find&Select eller Partial
Structure display).

IFC filtyper

ArchiCAD 6ppnar och sparar IFC 1 formatet 2x3. Tidigare IFC-format t ex 2x och 2x2
fungerar ocksa men de bor endast anvéndas om det krdvs pga annan applikation som inte har
stod for 2x3.

I ArchiCADs dialogfonster for 6ppna/spara finns det olika ifc-format:

.ifc IFC 2x3 file - normal okomprimerad.

.Afcxml IFX 2x3 XML file - rekommenderas nir det i projektet férekommer andra
applikationer som inte kan ldsa normal ifc men som kan importera xml-
databasen (t ex kalkylprogram, energiberdknngsprogram etc.). ifcxml ar ett
okomprimerat format.

.ifczip IFC/IFCXML 2x3 compressed file - komprimerad version av bade normala ifc
och xml-varianten. Ifczip ger en fil med storlek 25% av normalt (Tekla
Structures har stdd for ifczip).
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IFC kommandon

IFC-addon installeras automatiskt vid ArchiCAD-installationen. Nya betaversioner av IFC
laggs kontinuerligt ut pd http:// www.graphisoft.com/ifc/

Foljande IFC-relaterade kommandon finns tillgédngliga genom menyn File.

* Open
* Save as
* Merge

* [FC Translation Setup

* [FC Manager

* Options

*  Merge to IFC Model

* Detect [FC Model Changes

* Import Custom IFC Property Set

@ Edit View Design Document Options Teamwork ‘Window Test Help

L0 tew ‘o WP Ge | X EF @ s |8
e )
[0 Close Chrl+w R
o
. g Save Ctrl+5
@ Save as... Ctrl+shift+5 )
E.
él File Special (D‘ﬁ Merge... )
‘G External Content 4 El] DXF-DWG Translation Setup...
& Libraries and Objects 4 Smart Merge Options. ..
ﬁ Google Earth Connections ’| IFC 2x3 B35 IFC Translation Setup... A
\ Info ' Import 3D Studio file 4 % IFC Manager...
é% Plot Setup... % Options...
@ ﬁ Plot... b Merge to IFC madel...
@@ Page Setup...  Ctrl+Shift+p B Detect IFC Model Changes...
[[Ee Brint... Cri+p ”@ Import custom IFC Property Set... J
7
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Importera: Open and Merge

File > Open oppnar hela [IFC-modellen eller filtrerade delar. ArchiCAD omvandlar de
importerade elementen till motsvarande ArchiCAD-element.

Merge (File > File Special > Merge) adderar ("mergar’’) IFC-modellen (hel eller filtrerad) i
det 6ppna ArchiCAD-projektet och gor dd om IFC-elementen till ArchiCAD-element.

Obs: Merge skapar alltid fr.o.m. ArchiCAD 14 nya ArchiCAD-element. Om det 6ppna
projektet innehdller element med identiska (ifc guid) ID-nummer som element i den mergade
modellen kommer ArchiCAD att skapa nya element istéllet for att uppdatera de befintliga
elementen. Anledningen é&r att skydda informationen i det 6ppna projektet.

Tips: Merge fungerar endast d man stér i planvy i ArchiCAD.
Tips: Spara alltid ArchiCAD-modellen innan IFC-modellen “mergas”.

Importera IFC — steg-for-steg instruktion

1. Vilj translator
Vilj en av de translators som kommer med vid installationen eller egendefinierade. |
exemplet nedan 6ppnas IFC-modellen K-Stomme....ifczip frdn Tekla Structure. Nar
man klickar pA Oppna kommer ett dialogfonster “Model Filter” upp dér man kan vilja
vilka elementtyper man vill importera. Det gar ocksé att styra filtreringen via IFC-

translator.
@) Open file ' Model Filter for IFC 2x3 Import 3]
(< = m @ IFC-Guide T] Q Model Element List
NHETEF Namn 4 Andringsdatum
B HEIER — Select model elements you want to import
I Mats Macl5 f vld ! ( 1(
., Macintosh HD I 1 1 S
1 iDisk SN~ [Basement]
v [ IfcBeam
[5) CODEMETER 4 + [ IfcColumn
PLATSER - feb 2 1 + [ 1fcGrid
PLATS K-stomme ...Hotell.ifczip  Idag 14.34 i @ fcRamp
PR skrivbord ] . - a s + @ 1fcslab
~ ! + [ Ifewall
4 matsknutsson 1sat...lation 7.47 2 + @ IfcwallStandardCase
j"\ Program X \<at ' Y + [V First Floor
+ ™ Ground Floor
Enable: | IFC compressed file T] : :::;nd Floor
|_!Launch a new instance of ArchiCAD
Translator: Data exchange with Tekla Structures ﬂ f Settings... ) Group element list by: Story v
T— Cavbnt) @O » Filter Elements
Cancel L oK J
2. Vilj IFC format.
3. Vilj IFC-modell att importera.
4. Filtrera element
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Model Filter (se fig. ovan) gor det mojligt att ignorera translatorns
standardinstéllningar och istdllet applicera egna filter pd importen (se fig. ovan till
hoger). Model Filter ar valbart och aktiveras/avaktiveras i instéllningarna for
respektive translator under Import Options.

Obs: Element importerade genom Open eller Merge kan placeras pa speciella lager 1
ArchiCAD (definieras 1 translatorn). Syftet &r att separera importerade element fran de
befintliga i projektet.

Exportera: Save as IFC

Hela projektet eller filtrerade delar av projektet kan exporteras till IFC genom File > Save as.
Under exportprocessen mappas ArchiCAD-element enligt deras klassificering (automatiskt
eller manuell klassificering). P4 samma sétt som vid 6ppna ifc anvédnder man vid spara ifc
translators samt har mdjlighet att filtrera modellen genom ”Model Filter”.

Exportera IFC — steg-for-steg instruktion

1. Vilj translator

2. Filtrera modell

Filtrera om det behovs -> knappen Export under vilken man kan vélja att exportera
foljande:

* valda element (forutsétter att man har markerat element)

* synliga element alla véningar,

* synliga element aktuell vining (aktiv om du sparar fran planvyn)

* alla element aktuell vaning (aktiv om du sparar fran planvyn)

* hela modellen

3 Steg3.
Filtrera element

4 Vilj IFC-format

5 Vilj filnamn och exportera
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Save Plan 7 O Model Filter for IFC 2x3 Export
Model Element List
Spara som: Lounge Hotell s
o ] Select model elements you want to export:
Il a|p» |28/ = ml |G IFC-Guide v (Q
Selected: 21
Namn Andringsdatum v

ENHETER 1 unge Hotell.pin.ick - IfcBeam

B Mats Macls TR s ) IfcColumn

NG e D unge Hotell.bon . IfcDistributionFlowElement
I E iDisk B et e IfcSlab
i [l CODEMETER 4 EC 2x3 Ref...ce Cuide.ndf } 1 48 IfcSpace
| v PLATSER ArchiCAD SWE 2 If 27 apr 2010 13.45 A IfcStair

WA Skrivhard V£t reid e fceee  an N, i Ifcwall

Format: | IFC 2x3 compressed file =

Export: Visible elements (on all stories) B ( Model Filter... }

Translator: General Translator +9 ( Settings... C I e

byrpup e IFC Element Type ||
. . - T CTIE . ———
! Gom tillagg Ny mapp Avbryt Spara
_Z Filter Elements

Cancel ) ( oK 3

Tips!
Efter exporten ér det klokt att kontrollera IFC-modellen i en IFC-browser for att sékerstélla att

elementen &r rétt konverterade. Nedan listas ndgra kompetenta gratis IFC-browsers som kan
laddas ner frén:

- Solibri Model Viewer: http.//www.solibri.com
- DDS-CAD Viewer: http://www.dds-cad.net
- Nemetschek IFC-viewer: http.//www.nemetschek.co.uk/ifc

Ytterligare information om IFC finns pa: http://www.ifcwiki.org

10
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GRAPHISOFT.
Detect IFC Model Changes

File > File Special > IFC 2x3 > Detect IFC Model Changes...

Funktionen gor det mdjligt att jamfora tva olika IFC-modeller. Det dr en enkel form av
revideringskontroll. Funktionen hittar automatiskt skillnader 1 geometri mellan tva versioner
av samma projekt och de element som dndrats inforlivas ("mergas”) i det aktuella projektet
(som ocksa kan vara ett helt tomt projekt). Andringarna visas och hanteras i ArchiCADs
verktyg Mark-up (béde 2D och 3D).

} ” Mark-Up Tools
_‘ ¥ Mark-Up Tools
— — i ~<J Active Entry:
I | Modified Element 0003 »
Corrections:
\ o [ [@)EE
| Highlight Elements:
| I (o8] [oX

Zoom and Select:

A |

Column {Selected)
Stuchure: Structural Concrete
Base Elevation: 0 I
WjD: 300 / 300

Layer: IFC Im ported New

¥ Mark-Up Entries

Sort by:
& [z] | views »|

«_Deleted Element 0003 -~
«_»Modified Elerent 0001
«_rModified Element 0002

¢ »Modified Elerent 0003

«_rModified Element 0004
«_»New Element 0001
« »New Element 0002

Name: | Modified Element 0003
Style: [Modiﬁed Element D]

iy

— *:::I' m— Where: Ground Floor
Crested )] 3/6/2010 12:01:43 PM

» Tag and Discussion

‘ - i., —— [ Show Report of All Entries ]
|

Normalt kan man begrinsa dndringskollen till del av modellen (t ex element pa
bottenvaningen) eller till vissa typer av element (t ex bara pelare). Eftersom de tva
modellversionerna har olika datum kan f6ljande skillnader hittas automatiskt:

* Nya element
* Raderade element
* Modifierade element (position eller egenskaper)

Obs.
De tva versionerna maste vara gjorda med samma mjukvara och frdn samma projekt eftersom
alla element identifieras mha deras guid (interna ID). Om de tva IFC-versionerna kommer
frén olika program har alla element olika GUID och dndringskontrollen fungerar inte (allt
betraktas som nytt...).

11
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GRAPHISOFT.

Andringskontrollen hanterar inte 2D utan endast 3D-element (2D kommer att implementeras i
nista version av [FC).

Eftersom dndringarna “mergas” in 1 den 6ppna ArchiCAD-modellen rekommenderas att man
sparar projektet innan.

Tips. Man kan ocksa anvinda Detect Model Changes for att hitta fordndringar mellan tva
ArchiCAD-modeller. Spara t ex tva revideringar som IFC och anvénd Detect Model
Changes... En forutséttning for att det ska fungera ar att elementet sparas med GUID vilket
man stiller in under IFC Options (beskrivs i kapitlet ”Avancerade IFC-kunskaper™).

Steg 1.
Oppna dialogen for versionskontroll och bldddra fram de tvé versionerna av IFC-modellen
enligt nedan.

' IFC Model Change Detection Wizard E]

s Use this wizard to detect the differences between two IFC files that reflect
\l/ two different versions of a project model.
Only 3D elements will be considered, and will be paired by their unique ID.

Older version of the model:

C:\Models\structural model ver!.ifc
Newer version of the model:
Ci\Models\structural model ver2.ifc

Mote: It is important that you correctly identify which IFC file is the older project
version and which the newer version,

Steg 2.

Vilj vilka element du vill jimfora. Det forsta valet ”IFC Domain” dér man kan vélja kategori:
All, HVAC, Structural eller custom. Knappen Options ger fler valmdjligheter pa
elementtypsnivd. Group by och Element type ger tillsammans fler mojligheter att kombinera
filtrerering pd vaningar och element. T ex om man vill jimféra endast pelare pa plan 3.
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' IFC Model Change Detection Wizard @@

You can optionally narrow the set of elements to be compared.

IFC Domain: All element types v
Group by: Story and Layer v
Element Type: + Ground Floor

+ Basement
+ Second Floor

+ Roof
+ First Floor
+ [V Third Floor
< Previous l [ Next >

Steg 3.

Baserad pd de filter som stéllt in 1 steg 2 visar ArchiCAD en oversikt av de fordndringar som
processen har hittat. Fordndringarna mergas in i projektet som Mark-Up-objekt. For att kunna
skilja pd element frn de tva olika versionerna kommer de fordndrade elementen att placeras
pé olika lager. Anvind standarnamn, skriv in egna namn eller anvénd befintliga lager.

T IFC Model Change Detection Wizard @@

The followang changes vl be mergad to ArchiCAD as Mark-Up Entries:

New Elements 4
Modfied Elements 4
Deleted Elements 3

Choose two layers onto which to place these elements:

Deleted and Modified Elements from the older version:

IFC Imported Old E]
New and Modfied Elements from the newer version:
1FC Imported New E]
Cancel [ < Previous ] [ Merge ]
Steg 4.
Klicka pd Merge.
Steg S.
13
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Paletten Mark-Up 6ppnas automatiskt och listar
fordndringarna som mark-up entries (entry=upptéckt
fordndring) med férg efter status:

Andrat = blatt

Férgerna syns béde i 2D och 3D.

Ett dndrat entry innehdller bdde det gamla och det nya
elementet vilka kan skiljas 4t genom att de ligger i olika
lager enligt steg 3. Elementens lager visas i inforutan nér

muspekaren svédvar dver elementet.

Komplett beskrivning av Mark-Up tool finns i filmformat
pa hemsidan under BIM-IFC.

Om man tar bort en Mark-Up entry raderas alla element
som hor till.

14
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Mark-Up Tools
¥ Mark-Up Tools
Active Entry:
[ Deleted Element 0001 3
Corrections:

o [[@)Ea

Highlight Elements:

I (8] [oX

¥ Mark-Up Entries

Zoom and Select:

Sort by:
[ views |
- [5Ground Floor -~

e »\Deleted Element 0001

(@Modified Element 0001

B Madified Element 0002
@Modified Element 0003
{PModified Element 0004
@New Element 0001

<@New Element 0002 v

Name: | peleted Elernent 0001

Style: [ Deleted Element D]
Where: Ground Floor
Created ()] 3/6/2010 12:01:49 PM

[ Show Report of All Entries ]

» Tag and Discussion
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IFC Translators

ArchiCAD anviénder en translator (6verséttare) for att dppna och spara IFC-modeller.
Translatorn innehaller regler for hur elementen 1 ArchiCAD ska Oversittas till IFC-element pa
ett korrekt sitt. Det finns ett antal férdiga translators for vanliga cad-program. Det gar ocksa
att skapa egna translators vid behov. For att ange vilken translator som ska vara standard
(default) markerar man 6nskad translator och klickar sen pé en av knapparna med bla pilar
(export resp. import) 1 bilden nedan.

Available Translators

For att gora en ny translator duplicerar man en befintlig, doper om den till relevant namn och
stdller in den efter 6nskemal.

Translatorn dr en textfil som ligger pd datorn (sokvég visas i faltet Location).

Obs. Om man har dndrat en standardtranslator av misstag finns orginaltranslatorerna i mappen
GRAPHISOFT\ArchiCAD14\Defaults\IFC Translator folder. Anvéind dessa for att skriva
over den aktuella (felaktiga) som ligger under ”Current user’ \GRAPHISOFT\IFC Translators
14 folder.

En last translator kan inte modifieras.

% OO IFC Translation Setup

Available Translators

/’

Name ¥ Project  Partner Duplicate
Data Exchange with Analysis Applications )
Data Exchange with DDS-CAD MEP ( Rename...
Data Exchange with Nemetschek Allplan Engine )
Data Exchange with Scia Engineer ( Remove
Data exchange with Revit MEP P
Data exchange with Revit Structure ( Browse... )
Data exchange with Tekla Structures =
@ % General Translator Default for: = | e
Location: Macintosh HD:Anvandare:matsknutsson:Bibliotek:Application Support:Graphisoft:IFC Tr:
Description
Model Element Filter
Import Options
Export Options
( Revert Changes ) ( cancel )( Save Settings & Close
15
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Description

Hér kan man skriva in en egen beskrivning 6ver syfte, innehdll mm for vald translator.

Model Element Filter

Har stiller man in vilka klassificeringar som translatorn ska anvénda. Korrekt filtrering
forutsitter korrekt klassificering av elementen.

IFC Domain = All, Structural, HVAC (vent).
Structural Function = All, Load-bearing, non-load-bearing.

Convert annotations and all 2D elements
Nir detta alternativ dr ibockat exporteras f6ljande 2D-element till IFC: text, littra (label),

fyllningar, linjer, bagar, cirklar, polylines, splines och alla méttsittningstyper.

Hur 2D-elementen tolkas 1 IFC-filen paverkas ocksa av instédllningar i Export som 6ppnas fran
”Merge” eller ”Save as”.

Om 3D-fonstret dr aktivt vid utsparning av IFC exporteras 2D-element endast om “Entire
Project” &r valt.

Om planvyn dr aktiv vid utsparning av IFC exporteras endast synliga 2D-element (selected
elements only sparar bara markerade element).

2D-elementet visas 1 IFC-strukturen som IfcAnnotation. Matt exploderas till linjer och text.

Vid IFC-import till ArchiCAD Oversitts alla element av typen IfcAnnotation till linjer och
text nér detta val dr aktivt.

Obs. Dessa instéllningar pdverkar inte Grid Elements eller Grid Systems. Import/export av
Grid bestdms under IFC Domain > Model Filters.

16
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F Filter by Element Type

FC Domain: Structural N
= [ IfcElement A

Sl )1 f cBuidingElement

' IFC Translation Setup

Available Translators [ IfcBeam
_ = [V IfcBuldingElementComponent
Name v Project Partner Duplicate [¥) IfcBuildingElementPart
Data Exchange with Analysts Applications —_— = ¥ IfcReinforcingElement
Data Exchange with Revk MEP Rename. .. W) IFcReinforcingBar
Data Exchange with Revt Structure D ———— IfcReinforcingMesh
Data Exchange with Tekla Structures Remove IFcTendon
@ W, Genersl Translstor R IFcTendonAnchor
Browse. .. ™ IfcBuldingElementProxy
[ IfeColumn
: ]
Defauk for: E V] IfeCovering
) ™ IfeCurtanwall
Location: Ci\Documents and Settings\arechtorsz\Graphisoft\IFC Translators INT\Data Exchange with Tekla Structurd ) IfeDoor
[V IfcFooting
» Description o ) IfcMember
¥ Model Element Filter IfcPile v
-~ HVAC
Fiter Model Elements to Convert by Custom
IFC Domain: Structural v [_
Structural function: Al elements ~

Load-Bearing elements only
G t ot ati al 2D element
[ Convert annotations and . Non-Load-Bearing elements only l

» Import Options
» Export Options

[ Revert Changes ] Cancel ] [ Save Settings & Close ]

Import Options

Foljande speciella instéllningar for IFC-importen kan goras:

Show model filters in Import - 6ppnar fonstret Model Filter nidr man Oppnar eller mergar en
IFC-modell och ger mojligheter till ”override” av translatorns standardinstillningar.

Place Imported objects to... - bestimmer vilket/vilka lager IFC-elementen i1 den importerade
filen tilldelas.

Material Conversion — mappar importerade IFC-material till en skuren fyllning (cut fill) 1

ArchiCAD. Denna instéllning rekommenderas om du vet att ArchiCADs fyllningar inte har
samma namn som materialen i IFC-filen (géller bade File > Open och Merge).

17
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Import Options

[ Show Model Filter on import
Place Imported Elements to
() Imported layers
() A common new layer

O] Imported layers with extension

Material Conversion

| Use IFC Material - ArchiCAD Fill Type conversion table

Replace missing IFC Materials with:

GRAPHISOFT.

1) Om Use IFC Material...” inte dr ibockad scannar ArchiCAD vilka av den importerade
IFC-filens material som har ett namn som dr samma som hos en av ArchiCADs fyllningar.
Om ArchiCAD hittar en match kommer materialet fa korrekt fyllning. Om det inte finns

fyllning som matchar IFC-materialet anvénds alternativet “Replace missing IFC Materials

with”.

2) Om ”Use IFC Material...” dr ibockad ersétter ArchiCAD saknade [FC-material med
fyllningar enligt konverteringstabellen (klicka pa ”Conversion Table” {or att oppna den). Har
mappar man tillgidngliga fyllningar mot IFC-material. Tex kan man mappa materialet C20
frdn K-modellen till fyllningen for lattbetong. ArchiCAD skapar nu en ny fyllning som heter

C20 och som har samma fyllningsmonster som lattbetong.

*F Edit the conversion item

20

*F Conversion Table

Structural Concrete
Structural Concrete

Structural Concrete
Structural Concrete

» Availability and Screen-only Pattern
» Edit Vectorial Pattern

[ concel | oK
Material Conversion
e (E—TTTT—)
Replace missing IFC Materials with: “:I %% »‘

Om du inte mappar materialen kommer de att i fyllningen definierad som ”Replace missing

materials with.”

18
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Tips:

Flera av standardtranslatorerna har fordefinierade materialverséttningar som du kan utga
ifrn fOr att skapa egna varianter.

Konverteringstabellerna kan inte importeras eller exporteras som en separat xml-fil. Man
maste importera/exportera dem tillsammans med translatorn (anvind Browse for import).

Export Options

Export Options

Elements to export: Visible elements (on all stories) v

IFC Model Units...

Create IFC Site: without geometry ?]

Complex Element Options...

Derived Model Data to Export
__IFC Space boundaries __! Calculated area and volume
Tolerance between Spaces [mm]

__ Space containment __|Extended object properties

Elements to export — Filtrera de element som ska exporteras. Om elelement dr markerade nér
man ska exportera kommer alternativet ”Selected elements only” automatiskt aktiveras.

IFC Model Units — Vilj metrisk eller imperial (l&ngd, vinkel, area och volym)
Create IFC-site — sajten (markomradet) kan vara bade med och utan geometri. ArchiCAD
exporterar terrdng skapad med meshverktyget och element vars ifc-klass dr satt till Ifc2x_Site

(det gar t ex att modellera “risodling” med slabs och sitta dem till Ifc2X_Site).

Det finns tre olika metoder att exportera site med geometri (vdlj metod baserat pa vad
mottagande system kan hantera, ArchiCAD kan importera alla tre typerna):

* Boundary representation (BREP) — Solid 3D mark. Alla ytor &r plana och alla linjer
raka.

* Face-based surface (top surface) — Endast toppytan.

* Geometric set (wireframe) — Konturlinjer och punkter.
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Geometric set (Wireframe)

Face-based surface (top surface)

BREP
(Boundary representation)

Complex Element Options — géller for export av specialelement och kopplingarna mellan
dem.

* Extruded geometry — Detta dr rekommendationen for export ddr man i mottagande
program vill kunna editera elementens egenskaper (t ex hojd, bredd, placering av
referenslinje, kompositfyllning etc). Den storsta delen av de vanligaste egenskaperna
blir editerbara. Modellens geometri forenklas. Metoden Extruded geometry ar att
rekommendera nir man exporterar ArchiCAD-modellen till analysprogram (energi,
hallfasthet, statik, dynamik, etc) som fokuserar mer pé elementens egenskaper én pé
exakta komplexa geometrier.

* Precise geometry (BREP)- Denna metod dr den som bést beskriver elementets
geometri och dess kopplingar. Elementens egenskaper stods dock inte och
egenskaperna hos element exporterade till IFC med denna instdllning kan inte editeras.
Eftersom metoden dr den geometriskt mest korrekta ldmpar sig metoden for
samprojektering med referensmodeller ddr A och K har olika modeller men refererar
till varandras geometrier i samprojekteringen. Samarbetet mellan ArchiCAD och
Tekla Structures m fl bygger pa denna metod.

Modelleringssituationer som illustrerar skillnaderna mellan de tvd metoderna:

1) Viggar med complex profile och koppling.

20
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Med BREP:

* Om du har vigg som inte dr lutande, dubbelt lutande eller complex och som ér
kopplad till en vigg med annan geometri kommer bdda dessa vidggar att
exporteras med BREP.

* Om tva véggar som dr kopplade inte har samma hdjd kommer bada att
exporteras med BREP.

Med Extruded geometry:
* De flesta enkla viggar exporteras med extruded geometry.

Bilden nedan visar tydligt skillnaden pa export med de tva olika metoderna.

Extruded geometry
Precise geometry (BREP)
2) Kopplade balkar
Med BREP:
* Balkarna exporteras precis som de ser ut i ArchiCAD och med automatiska
anslutningar.
Med Extruded geometry:

* Balkarna exporteras med sin exakta geometri och utan automatiska anslutningar.
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Extruded geometry

Precise geometry (BREP)

3) Bjilklag med lutande kanter

Med BREP:
* Bjilklagen exporteras med korrekt geometri.

Med Extruded geometry:

* Bjilklagen exporteras med vertikala kanter &ven om de 1 ArchiCAD-modellen ér
lutande.

Extruded geometry

Precise geometry (BREP)

Foljande ytterligare instéllningar gor det mojligt att exportera tilliggsinformation som kan
anvandas frimst i kalkyl- och energiprogram.

IFC Space Boundaries (zongranser)
Zonerna 1 ArchiCAD innehéller information som ar anvandbar i t ex
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energiberdkningsprogram. Zoner ar ur ett geometriskt perspektiv 3D solider som omges av
tva bjélklag och ett antal viggar.

Space boundaries definierar den logiska kopplingen mellan ArchiCAD-zoner (IfcSpace) och
byggnadselementen som omger zonen. [ praktiken har alla byggelement; viggar, pelare,
balkar, fonster, dorrar, bjélklag etc olika energiegenskaper som behdver tas med i en
energiberdkning.

Genom att aktivera "IFC Space boundaries” kommer ArchiCAD att exportera alla zongrénser
samt deras relation (IfcRelSpaceBoundary) till zonen tillsammans med sjdlva zonerna.

Med andra ord berdknar ArchiCAD position och storlek pa de element som omger varje zon.
ArchiCAD delar in zongrénserna enligt deras areor, definierade och skurna med de element
och dppningar som &r kopplade till gransen. Se fig. nedan.

Zone1
Space Boundaries (defined by Walls): Space Boundaries (defined by Slab):
1-Wall part defined by Zone3 1 - Slab part defined by Zone
2 - Wall part defined by Zone2 2 - Slab part defined by Zone3
3 -Wall part cut by connected wall 3 - Slab part defined by Zone2
4 and 5 - Area defined by door opening 4 - Slab part without thermal convection

Instéllningen “Tolerance between Spaces” avser maximalt avstand mellan angrénsande zoner.
I praktiken kan man d& sétta en begrinsning pa elementets tjocklek (som ska tas med i
berdkningen).

Obs. Berdkningar med Space boundary fungerar endast dd zonen skapats med

geometrimetoden Inner edge 1 ArchiCAD.
@)

ID:  [Ro02

1 [—
Default Settings [EH @ B A-Umommem T » o[_L, “ 'ﬁ ‘

Info

Calculated area and volume — Aktiverar méngdningsparametrar for vigg, balk, bjdlklag, tak
och zon. Parametrarna anvénds framst i kalkylprogram.

Exempel pa parametrar som kan exporteras fran en vagg:
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Hojd

Omkrets

Bruttovolym

Nettovolym (volym reduceras av t ex pelare, nischer mm)
Golvyta (brutto och netto)

Viggyta netto (reducerad med dppningarnas yta)

Space containment — Anvinds dd modellen exporteras till ett forvaltningssystem. Space
containment definierar relationen mellan ArchiCADs zoner och méblering och ventilation
samt andra element som ligger inom zonen.

Extended object properties — Om IFC-modellen dr tdnkt att gora en “round-trip” (mergas
tillbaka 1 ArchiCAD) bor denna box kryssas i. Det ger ArchiCAD méjlighet att mappa till
orginalelementen da IFC-modellen dterimporteras. Obs. Filstorleken okar avsevirt med detta
alternativ.

24
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Model Filter

Varje IFC translator innehaller generella instillningar
for vilka element som ska importeras eller exporteras
(se Model Element Filters).

Fonstret "Model Filter” (fig. till hoger) som kommer
upp direkt vid importera eller spara ger dig dock
mojligheten att finjustera filtreringen &dnda ner pa
individuell elementniva. Funktionerna i Mode Filter
varierar beroende pd om det géller import eller export
av IFC-modell.

Obs: Filtret ”By Structural Function” fungerar olika
vid import och export:

IFC import — filtret avser ”"LoadBearing”)

IFC export — filtret avser klassificeringen Structural
Function”.

25
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o Model Filter for IFC 2x3 Import 3]

Model Element List

Select model elements you want to import:

Selected: 458

+ [l Basement
- First Floor
SftlifcSlab]

SLA - 002
SLA - 003
SLA - 004

+ Ground Floor

+ Roof

+ Second Floor

+ Third Floor

Group element list by: Story v
¥ Filter Elements
By IFC Domain:
Structural v
By Structural Function:
All elements v
cancel | | oK
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Avancerad IFC

Avsnittet behandlar ytterligare IFC-instéllningar, -funktioner och -verktyg for ArchiCAD-
anvindare som redan kan grunderna i IFC.

Ordlista for IFC-relaterade begrepp

GUID - Globally Unique Identifier

En textstrang kopplad till varje unikt element for att de ska kunna identifieras. GUID gor det
mojligt for olika dataprogram att identifiera samma element. ArchiCADs interna GUID ar
inte samma som [FC-GUID for ett element.

IFC Entity

Projektinformation frdn ArchiCAD som sparas till IFC representeras av “entities” - t ex
element, material och deras relationer. Varje “entitet”, t ex en ifcWall, har ett bestimt antal
attribut plus obegrénsat antal ytterligare egenskaper.

Attribute

Attribut definierar en IFC entity. Ett markerat elements attribut kan visas och kontrolleras
med ArchiCADs IFC-manager. IfcWall har som exempel foljande attribut: GloballD (=IFC
GUID), Name, Description, ObjectType och Tag (tag=mérkning och utgdrs default av
ArchiCADs GUID).

IFC Manager - IFC 2x Edition 3
Containment Structure: E]E] [ Create New Property ] Selected:1
- Default Project PN Name T
- <& Default Site 2
- {5 Default Building
+ [P Roof
+ [ Third Floor v Attributes (IfcColumn)
- [I Second Floor
+ T Beams (S)
- T Columns (25
E j cre _(00)3 [ Description
[FWCRE - 003 [J ObjectType
§ CRE-003
Property

Property ér extra egenskaper som en IFC entity innehdller. Properties grupperas 1 Property
sets (Psets). Som default innehaller de flesta IFC entiteterna standard Psets tillgéngliga for
alla dataprogram som &r kompatibla med IFC 2x3.
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MName Yalue

3 Attributes {(IfcColumn)
[ Rreference
[ Slope 0

[ FireRating
Pset_ConcreteElementGeneral
Pset_ConcreteElementQuantit...
Pset_ConcreteElementSurface...
Pset_PrecastConcreteElement...
Pset_ReinforcementBarPitchOf...
Pset_Draughting
Pset_FlementShading
Pset_FireRatingProperties
Pset_ManufacturerOccurrence
Pset_ManufacturerTypeInform...
Pset_QuantityTakeOff
Pset_Risk
Pset_PackingInstructions
Pset_ProductRequirements
Pset_Reliability

N T TV YV VYV VNV VSYSYSSYSSYYY

IFC Manager ger anvindaren mdjlighet att se innehallet 1 och editera Psets. Det gar dven att
skapa nya standardproperties samt custom properties som kan anvédndas vid IFC-exporten.

Obs: Foljande IFC-properties, som bestdms av klassifikation 1 ArchiCAD, kan inte
modifieras i [IFC Manager.

IsExternal (bestims genom klassificeringen “’Position”)

LoadBearing (bestims genom klassificeringen ”Structural Function™)

IFC Options

De flesta IFC-instéllningarna modifieras i Translatorn. Det finns dock mer detaljerade
instéllningar som man endast behover 1 specialfall och de hittar man under File > File Special
> [FC 2x3 > Options.
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o IFC 2x3 Options 3

["1Open Express Data Manager (EDM) before import and export

[ Custom Property Set... ]

[ Model Element Author. .. ]

IFC Global Unique Identifiers (GUID)

(3) Keep element identifiers

() Generate new element identifiers when save IFC

IFC Keywords
(%) Use standard english names (Recommended)

() Use localized names

Open Express Data Manager (EDM) before import and export

EDM ér motorn som ligger mellan ArchiCAD och IFC. Den gér om IFC-modellen till
ArchiCAD-modell vid import och vice versa for export. Genom att aktivera detta alternativ

ser man dialogen innan import och export och ger anvindaren mdjlighet att bestimma platsen
for EDM-databasen.

o' IFC 2x3 Options

[V] Open Express Data Manager (EDM) before import and export

- ¥ Reading the STEP file
| Eixom Property Set. .,

[ Model Eremm DB Location: C:\Documents and Settings\arechtorisz\Local Settings\Application Dat
IFC Global Unique Identifiers (GUID) DB Name: &2 - @
() Keep element identifiers % O Fxarept
(O Generate new element identifiers when save 1§ Passord: b ) DataRepository
IFC Keywords SR A IFc2x3Repl
() Use standard english names (Recommended) Model: Ifc2x3ModelExt 1
() Use localized names
[ Refresh ] [ Cancel ] [ oK ]
Cancel e p—

Custom Property Set...

Anvind dessa for att konvertera parametrar for alla eller valda ArchiCAD biblioteksdelar till
IFC properties. ArchiCADs properties kan hir ocksa ldggas till standard IFC property set.

Genom att klicka 1 ”Generate Configuration File...” kan man vilja bilioteksdelar och deras
parametrar for IFC-exporten. Bocka forst 1 biblioteksdelens namn under Libparts (ex
Armchair 01 14) och vilj sedan under Parameters fran de tillgingliga parametrarna (ex Cost).
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D6p om namnet pd aktuellt Property set med Rename vid behov.

' Edit Configuration File

Libparts

Mame

[ Architrave 02 14

Armchair 01 14
[ armchair 02 14
[ armchair 03 14
[] armehair 04 14

L N

Parameters

Propertyset name
[] GSPset AC14 Armchair 01 14
[ Gseset AC14 Armchair 01 14
GSPset AC14 Armchair 01 14
[ Gseset AC14 Armchair 01 14
[] GSPset AC14 Armchair 01 14
[] Gspset AC14 Armchair 01 14

L S R I T R PP}

£

Group Type Name Type ACParamMName ACParamType Of
Property Bottom Level IfcReal ac_bottomlewvel Real Fal &
Property Contour Pen IfcInteger gs_cont_pen Integer Fal
@ Property Cost IfcReal gs_list_cost Real Fal
Property Cushion Thickness  IfcReal CushThk Real Fal
Property Edge Radius of Cushii IfcReal RadCushEdge Real Fal
Property Fill Background Pen IfcInteger gs_back_pen Integer Fal a
[, e TETate e — e e I i
>

| Create GSPset AC14 Armchair 01 14

4 GUID
{C3FBFD18-2BC3-4F1E-B1C2-15A9497311151-{63405FF4-91BE-4CES-9F A2-CSD093COD0 16 »
{2D76CB62-4553-4250-BCEA-8927B18E49F8}-{3B2518DD-DIES-4BCh-9ABE-EIDS7I0E04B3}
{21A1E883-409B-4E21-B 140-0B07056 3CFS4}-{C20E6DC0-4E 1F-4090-90C5-BCAD4DSET02F
{89A65049-7CF1-4013-B977-3BE70DB728BD }-{884A6D31-5FD3-403B8-924F-B473AC18B18B}
{EFIDESFD-6F57-473F-B03D-F 14E 9465 A6FD - { C473E689-ADBE-42FF-B63A-92FB1AS4C21D )

(M AAFAFEER. ARAF 447 A AFDA 49 AAIFET4~ART (AFFRAFESSA FOAA ARAR ADFD A% A6 AN mATa)

’ I Rename | [ Cancel ] [ Save ]

Obs: Create doper bara om markerat property set medan Rename doper om namn pé alla
property sets som hor till det markerade biblioteksobjektet.

Tips: Parametrar kan exporteras som standard IFC properties (som 1 sin tur tolkas av
dataprogram som dr kompatibla med aktuell IFC-version) om man &ndrar namnen pa property
sets och parametrar till IFC standarnamn. T ex modifiera ArchiCADs Fire Rating parameter
for en dorr till standard IFC attribut genom att ge property set namnet Pset DoorCommon
samt parametern Name till FireRating.
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=F Edit Configuration File

Libparts " " " "
5 o Edit Configuration File
Name GUID
Libparts
[ D1 Double Acting 14 {E141B9B3-D2FE-4142-B45C- ATDIDSOFD19E }-{EI

[ D1 Entrance 14 {90BBF2CF-0C3A-4FBC-9D3A-C2B431CB76D8)-{C Name GUID
[ D1 Entrance side 14 {7DE73DAA-8220-4354-BESA-D27F7FAF0314)- {78 | [] D1 Double Acting 14 {E1A18989-D2FB-4142-B45C-A7DIDSOFD19E} - {EE4BFC21-4D5B-4F ID-Ad64- IDOAE4SEBSAG) A
[ D1 Entrance side2 14 {6464BFD7-6444-4769-BE43-27F AAB35D65) {3564 DA Icn ta ) {90BBF2CF-0C3A-4FBC-9D3A-C2B431CB76D8}-{CCCBBIBE-2077-4183-8721-8BD67F31862F ;.
[ D1 Entrance St 14 {8310C368-22F9-47C7-8F0D-2683200 13098} -{CCG | [ D1 Entrance sidet 14 {7DE73DAA-8220-4354-BESA-D27F7F AR 0314} -{7B0785DE-3F56-4D66-3479-3A36CEFD2823}
PAnirade. i (EAFPANE AGKE 4FFY APIP RP44PARAMRAM (e [ D1 Entrance side2 14 {6464EFD7- 769-BE. S }-{958A6ES1-ADOD-4D27-AE7-FSCABIABCESE}
[ D1 Entrance St 14 {8310C368-22F9-47C7-3F0D-268320D 13D9B} - {CC553321-DIIC-42EB-3D76-FIBEBSFDI7S 1}
M ne oo e e P RS —
Parameters
Propertyset name Group Type Name Type
[ GSPset AC14 D1 Entrance 14 Property Finjsh TfeString Darameters
[ GSPset AC14D1Entrance 14 [ID] Property D ropertyset name Group Type Name Type ACParamName ACParamType Optio
[ EereerneTs Property e Signage IfeString Pset_DoorCommon Property N
[ GSPset AC14 D1 Entrance 14 Property Floor Plan Display O Ifclnteger [ Pset_DoorCommon D) Property ) FireRating ) Feait] gs_list_firerating String False
[ GSPset AC14 D1 Entrance 14 Property Frame Contour Pen  IfcInteger Property
[] GSPset AC14 D1 Entrance 14 Property Frame Element Joiner IfcString [ GSPset AC14 D1 Entrance 14 Property IfcInteger gs_CasingInTypeEnal Integer False
) Aened AS A A Fabin e Al P Al Tt [ GSPset AC14 D1 Entrance 14 Property Ifcinteger  gs_CasingOutTypeEn Integer False
[ GSPset AC14D1 Entrance 14 Property 2D Detail Level TfcString gs_detlevel 20 String False

:
[V [ Y PR P PR Y eSO — annairo.Li. FEn [

Klicka péd Save aktiverar Use custom property set configuration” och sparar instdllningarna i
konfigurationsfilen (konfigurationsfilen ar en vanlig .xml-fil).

Med Browse kan man skippa ovanstaende steg och direkt ladda annan befintlig
konfigurationsfil.

Genom att klicka pé knappen Edit Configuration File for att modifiera instéllningarna i den
aktiva konfigurationsfilen.

Model Element Author anvinds fOr att skriva in generell information om projektets dgare
(person) samt organisation. Denna information (IfcOwnerHistory) kommer att ldggas till varje
exporterat element. Vid import/export kan man gruppera IFC-elementen med denna
information (owner).

IFC Global Unique Identifiers (GUID)

Alternativet ”Keep Element Identifiers” innebér att IFC GUIDs som ArchiCAD-element
tilldelats tidigare hanger kvar under nésta ”Save as IFC”-process. Fordelen med att elementen
har samma GUID ér att det blir enkelt att upptécka fordndringar i position eller geometri hos
elementen. Denna instédllning dr nédvéndig for att ArchiCADs Detect IFC Model Changes ska
fungera (samma princip for alla dataprogram som jamfor tva olika versioner av samma
modell — elementen méste ha samma GUID {or att det ska fungera). Alternativet &r ”Generate
new element identifiers” vilket innebér att alla element far nya GUIDs vid varje IFC-export.

IFC Keywords

Péverkar vilket sprdk som IFC dialogen anvénder (engelska eller anpassad).
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Merge to IFC Model

Merge to IFC Model innebir att sla ihop aktuell IFC-modell med en befintlig. Merge later
anvéndaren filtrera vilka element frn det 6ppna projektet som ska mergas med det befintliga
(inte Sppet).

Stegen for Merge dr samma som for Save as med foljande undantag:

*  Merge kommer inte att skapa en ny fil utan mergar édndringarna till den befintliga filen.
Element som inte d@ndrats paverkas inte.

*  GUID behélls alltid vid Merge (tidigare beskriven funktion som ger mojlighet att ge olika
GUID vid varje IFC-export giller alltsa inte for Merge).

IFC Manager

IFC Manager visar strukturen i1 det dppnade projektets IFC-databas. Funktioner i IFC
Manager:

IFC Manager - IFC 2x Edition 3
Containment Structure [—_] - 4 [ Create New Property Selected:1
= [£] Default Project A Narme Vahe Unit  Type
= < Defauk Site 2
= By Defauk Building
+ g Rocf
+ [Bq Third Floor v Attributes (IfcColumn)
= [y Second Floor
+ TE Beams (5)
= T Columns (25) -
§ CRE-003 [ Dpescription
[FICRE - 003 [0 objectType
J CRE-003
q CRE -003 Pset_ColumnCommon
§ CRE-003 .
§ cre-003 Pset_ConcreteElementGeneral
§ CRE-003 Pset_ConcreteElementQuantit...
§ CRE-003 v Pset_ConcreteElementSurface...

Pset_PrecastConcreteElement...

Grouping Information: @@

= __] Grouping information
1 IFC Groups
1 IFC Zones

Pset_ReinforcementBarPitchOf...
Pset_Draughting
Pset_ElementShading
Pset_FireRatingProperties
Pset_ManufacturerOccurrence
Pset_ManufacturerTypelInform...
Pset_Quantity TakeOff
Pset_Risk
Pset_PackingInstructions
Pset_ProductRequirements
Pset_Reliability

{ Show Selection on Floor Plan ]

TV VV VVVVVVVVVVVYVYVVYVY

{ Synchronize Tree to Plan ]

. Lista entiteter hos elementen 1 det 6ppna ArchiCAD-projektet.
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. Fraga efter IFC-attribut, properties och property sets tillagda till ArchiCAD-elementen.
. Editera IFC properties och property sets.
. Légga till nya properties (utover default) till IFC-entiteter for senare IFC-export.

. Skapa nya properties och custom property sets.
. Hitta element (IFC entities) bade i ArchiCAD-modellen och i den skapade IFC-
modellen.

. Navigera mellan ArchiCAD- och IFC-modellen.
. Uppdatera hela ArchiCAD-projektet med dndringar i IFC-modellen
. Gruppera element och zoner.

Containment structure visar IFC-strukturen dvergripande (IfcProject > IfcSite > IfcBuilding
>[fc(Building)Story > IfcEntity) och listar IFC-entiteter individuellt enligt deras klassifikation
1 ArchiCAD (IFC Element Type).

Den hogra delen av fonstret visar attribut och egenskaper for element markerat i vénstra
delen.

Som tillagg till default IFC properties kan ytterligare properties enkelt 1dggas till for varje
element. T ex l4dgga till double glazing som en ny egenskap for fonster genom att skriva 72”1
faltet Value for Pset DoorWindowGlazingType > GlassLayers property.

FC Manager - IFC 2x Edition 3
Containment Structure: @@ [ Create New Property ] Selected:1
+ E IfcWindowsStyle - IFC A Name value Unit  Type
+ T IFcwindowsStyle - IFC a

+ T Ifcwindowstyle - IFC
+ T2 Ifewindowstyle - IFC
+ T Ifcwindowstyle - IFC v Attributes (IfcWindow)
+ T IFcwindowstyle - IFC
+ T2 Ifewindowstyle - IFC
+ T IFcwindowstyle - IFC

5 T Ifewindowstyle - IFC 0] Description

+ T Ifcwindowstyle - IFC [J ObjectType
# T2 Ifewindowstyle - IFC
t E IFewindowStyle - IFC A Pset_DoorWindowGlazingType
+ T IFewindowstyle - IFC
1. E IfcWindowstyle - W T GlassLayers B IfcCount|
) = D - 001] [ GlassThickness1 0 IfcPositive
A O GlassThickness2 0 IfcPositive
< >
[ GlassThickness3 0 IfcPositive

For att hitta element 1 strukturen map deras IFC GUID, skriv deras GUID eller del av det i
féltet under Containment Structure och klicka pa ”Search by GUID”. Vilj ndgot element 1
listan under sokfiltet och elementet markera och kan hittas i strukturen ovanfor.
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IFC Manager - IFC 2x Edition 3

Containment Structure: E]@ [ Create New Property Selected:1
- Default Project A Name Value Unit  Type
= < Default Site A
- {I% Default Building
= [g Roof
- TEi Beams (10) ¥ Attributes (IfcBeam)
@ BMR - 004
& EVMR - 017 /

[J Description
[ ObjectType

Pset_BeamCommon

Pset_ConcreteElementGeneral

Clear results

27mK34-
Pset_ConcreteElementQuantit...

27mK34pKFgAfhGlglUgv] Pset_ConcreteElementSurface...

Pset_PrecastConcreteElement...
Pset_ReinforcementBarPitchOf...

vV VIV YVVY

Pset_Draughting

Paletten IFC Manager kan vara dppen samtidigt som du jobbar 1 ArchiCAD (paletter som
fungerar pa det viset kallas “modeless™).

Om du lagger till, tar bort eller modifierar element i ArchiCAD, klicka pa Synchronize Tree
to Plan for att uppdatera IFC-strukturen.

For att hitta ett eller flera IFC-entiteter i ArchiCAD-modellen, vélj dem i trddstrukturen och
klicka sedan Show Selection on Floor Plan. ArchiCAD markerar och zoomar dé in pa
elementen 1 ArchiCAD som motsvarar de markerade IFC-entiteterna.

Klicka pd Show Selection in Tree for att 1 IFC-strukturen visa element markerade 1 2D eller
3D 1 ArchiCAD.
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FC Manager - IFC 2x Edition 3

EE

= Default Project -
= & Default Site
= {B Default Building
= [y Roof
= TE Beams (10)
&@ BUR - 004
& BMR - 017
@
& BMR - 017
BMR - 017
BMR - 017
BMR - 017
BMR - 017
e BMR - 017
& BIR - 017

Containment Structure:

v

BE

Grouping Infrmagon:

'oupjng information
IFE Groups
Zones

SR |

Show Selection in Tree |

Show Selection on Floor Plan

Synchronize Tree to Plan |

M=

For vissa applikationer (huvudsakligen forvaltnings- och kalkylsystem) kan det vara effektivt
att gruppera IFC-entiteter och applicera nya properties och property sets pa dessa grupper.
Anvind Grouping Information fOr att gruppera entiteterna. Det finns tva typer av grupper:

1. IFC Groups: Dessa kan innehdlla IFC entiteter av olika typer (t ex tvd pelare och en

balk).

2. IFC Zones: Dessa innehéller endast IfcSpaces genererade fran ArchiCADs zoner
(man kan gruppera alla zoner som har samma funktion).
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FC Manager - IFC 2x Edition 3

Containment Structure:

EE)

= Default Project -~
= <& Default Site
- ff Default Building
- [P Roof
+ T Beams (10)
+ TEi Slabs (2)
- [ Third Floor
+ T walls (1)
= [Bg Second Floor
+ TEi Beams (5)
+ T Columns (25) v

B

Grouping 'ormation:

- ] Grouping information
=-|_J IFC Groups

=@
- Ei Beams (1)

& BMR - 017

= T Columns (2)
ﬁ CRE - 003
[J CRE-003
_J IFC Zones

( Delete Group ]

| |

Create New Property ]

v

MName

Attributes (IfcGroup)

MName

O Description

[ ObjectType
Pset_Risk

For att skapa en ”IFC Groups” eller IFC Zones™:

GRAPHISOFT.

Selected:1

Value Unit  Type

Bar elements

1. Vilj en grupp genom att klicka pa IFC Groups/IFC Zones mapparna under Grouping

Information.

Bestim namnet.

ARl ol

malgruppen.

Create New Property

Klicka pd New Group/New Zone.

Editera attributen och/eller innehéll i befintliga egenskaper.
Definiera nya properties med Create New Property vid behov.
Dra och sldpp entiteter (element) fran tradstrukturen (Containment Structure) till

For att skapa en ny IFC Property for en entitet (ArchiCAD-element) eller IFC Group, klicka

pé knappen Create New Property.
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o' Create User Defined IFC Property 3
Existing Property Set: New Property Set 3
Mame of Property Set: architect properties|
Name of Property:

Type of Property: IfcBoolean v
Simple Property Type: Single Value -
[ Cancel ] [ OK ]

1. Skapa ett custom Property Set (Name of Property Set).

2. Skriv in den nya propertyns namn.

3. Vilj typ av property i drop-downlistan.

4. Ange virdet pé property type.

5. For att lagga till ytterligare ny property till befintligt property set, klicka pa New Property
igen och vilj ett befintligt property set frdn drop-downlistan och definiera ny property med
namn, property type och value.

Tips: For att undvika fel, anvidnd inte standard PSET-prefix nér du skriver in namnet pa ditt
nya custom Property Set.

Import Custom IFC Property Set

Detta kommando uppdaterar biblioteksdelens (objekt, dorr, fonster, skylight, zon, lampa)
egenskaper 1 det 6ppna ArchiCAD-projektet med properties fran vald IFC-fil genom att
anvinda Custom Property Set configuration file.

Obs: Custom Property Set configuration maste genereras innan man anvédnder Import Custom
IFC Property Set (se IFC Options).
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Speciella applikationer

Tekla Structures

Forenkla Teklamodellen innan IFC-export till ArchiCAD.

Nedan beskrivs tre metoder for att forenkla modellen fran Tekla innan export till ArchiCAD.
Forenklingens syfte ar frimst att for minga detaljer gor samgranskningen i ArchiCAD
langsam. Arkitekten behdver inte heller alla detaljer som plétar, skruvar, bultar, armering etc.
om de inte “’sticker ut” utanfor och paverkar arkitektmodellen synligt eller funktionsmassigt.

1. Sortera bort platar, skruvar/bultar, armering

Skruv och armering fir man bara med vid exporten om man aktivt kryssar for det. Platar mm
kommer med om man véljer med "select objects in components". De flesta anvénder "select
components" och d4 missar man plétarna.

2. Sortera med hjilp av IFC klass (IFC entity)

I varje dels egenskaper (part properties > user defined attributes, fliken "IFC Export”) sd finns
det ett attribut som heter "IFC entity”. Normalt dr den satt till ”auto” vilket innebér att delens
typ sétts till "IfcBeam” om delen &r en balk osv. Man kan dven sjdlv sitta typen ifall man
anvénder ett visst verktyg for att skapa en del men vill ha annan typ. I listan pa IFC entity
finns dven valet "None”. Viljer man det s& kommer delen ej med vid IFC export. Man kan pa
sa sitt enkelt exkludera valda delar sd att de aldrig kommer med vid IFC export. Detta kan
vara bra d4 man har modellerat upp befintliga delar eller annat som man skall ansluta till eller
olika hjdlpobjekt, dessa objekt vill man kanske inte exportera for de ingér inte i den
overenskomna informationsleveransen. Satter man attributet "None” dr man skyddad for att {a
med dem av misstag.

a Tekla Structures x64 Concrete column (1) &
Kvalitétskontroll } Unitechnik } EiPlan | BVBS l MAP coordinates
Parameters ’ Betong 1 Status End Conditions ‘ Analysis IFC export
IFC entity 7 T -
IFC export type v Auto -
IFC building name v
IFC building storey name v

3. Sortera oberoende av klassificering

Man kan 1 Tekla ange en parameter, typ "ej export" under ett UDA (user defined attribute)
som man filtrerar bort vid [IFC-exporten. Denna metod ger frihet men krédver att man tanker
igenom vad som ska exporteras.
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